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Thank you for purchasing this Canon product. Please read this manual thoroughly before 
operating the product in order to familiarize yourself with its capabilities, and to make the 
most of its many functions. After reading this manual, store it in a safe place for future 
reference.

 

Symbols Used in This Manual
The following symbols are used in this manual to explain procedures, restrictions, 
handling precautions, and instructions that should be observed for safety.

IMPORTANT
.

Indicates operational requirements and restrictions. Be sure to read 
these items carefully in order to operate the product correctly, and to 
avoid damage to the product.

NOTE
.

Indicates a clarification of an operation, or contains additional 
explanations for a procedure. Reading these notes is highly 
recommended.

 

Buttons Used in This Manual
The following button names are a few examples of how buttons to be clicked are 
expressed in this manual:

Preface

How to Use This Manual

Buttons on Computer Operation Screens: [Button Name]

Examples: [OK]

[Next]
viii



 

Displays Used in This Manual
Screen shots of computer operation screens used in this manual may differ from 
the ones you actually see, depending on the operating system and the model or 
options that come with your machine.

The buttons that you should click are marked with a , as shown below.

When multiple buttons can be clicked, they are highlighted and mentioned in the 
order in which they should be clicked.

Click this button 
for operation.

5 In the first dialog box of the Fax Driver Setup Wizard, click
[Next].
ix



 

Abbreviations Used in This Manual
In this manual, product names and model names are abbreviated as follows:

Microsoft® Windows® 98 operating system: Windows 98

Microsoft® Windows® Millennium Edition operating system: Windows Me

Microsoft® Windows NT® 4.0 operating system: Windows NT 4.0

Microsoft® Windows® 2000 operating system: Windows 2000

Microsoft® Windows® XP operating system: Windows XP

Microsoft® Windows Server  2003 operating system: Windows Server 
2003
x
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Disclaimers
The information in this document is subject to change without notice.
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Before You Start

This chapter describes the system environments required for using the fax driver. It also 
explains where to find help and information regarding the installation and use of this driver.
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Introduction
The fax driver gives users of Microsoft Windows 98, Windows Millennium Edition, 
Windows NT Version 4.0, Windows 2000, Windows XP, or Windows Server 2003 
(hereafter called Windows 98/Me/NT 4.0/2000/XP/Server 2003) operating system 
the ability to make full use of the fax function of the printer. If your printer is 
equipped with the optional fax subsystem, the fax driver enables you to access the 
fax function.

The fax driver is conceptually akin to a printer driver. A user would select [Print] 
from any Windows application software, select the Canon fax driver as the printer, 
and specify its destination(s) and options.

The fax driver would then convert this into an image that conforms to standard fax 
protocols, to be printed or stored on the recipient fax machine(s).

 

Supported Canon Products
The Fax Driver Version 3.95 is available for the following Canon products:

Printer Name Driver Name

Color imageRUNNER C2620 Canon iR C2620 (FAX)

imagePASS-C1 (Color iR C2620-C1) Canon iR C2620-C1 (FAX)

imagePASS-C2 (Color iR C2620-C2) Canon iR C2620-C2 (FAX)

Color imageRUNNER C3200 Canon iR C3200 (FAX)

imagePASS-C1 (Color iR C3200-C1) Canon iR C3200-C1 (FAX)

Color imageRUNNER C3220 Canon iR C3220 (FAX)

imagePASS-C1 (Color iR C3220-C1) Canon iR C3220-C1 (FAX)

imagePASS-C2 (Color iR C3220-C2) Canon iR C3220-C2 (FAX)

imageRUNNER C3100 Canon iR C3100 (FAX)

imagePASS-E1 (iR C3100-E1) Canon iR C3100-E1 (FAX)

imageRUNNER C3170i Canon iR C3170 (FAX)

imageRUNNER C3170U Canon iR C3170 (FAX)

imageRUNNER C5800 Canon iR C5800 (FAX)

imagePASS-D1 (iR C5800-D1) Canon iR C5800-D1 (FAX)

imageRUNNER C5870U Canon iR C5870 (FAX)
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imagePASS-G1 (iR C5870-G1) Canon iR C5870-G1 (FAX)

imageRUNNER C6800 Canon iR C6800 (FAX)

imagePASS-D1 (iR C6800-D1) Canon iR C6800-D1 (FAX)

imageRUNNER C6870U Canon iR C6870 (FAX)

imagePASS-G1 (iR C6870-G1) Canon iR C6870-G1 (FAX)

imageRUNNER 2010F Canon iR1600-2000 (FAX)

imageRUNNER 2016 Canon iR2016 (FAX)

imageRUNNER 2020 Canon iR2020 (FAX)

imageRUNNER 2230 Canon iR2230 (FAX)

imageRUNNER 2830 Canon iR2830 (FAX)

imageRUNNER 2870/2270 Canon iR2270/iR2870 (FAX)

imageRUNNER 2870G/2270G Canon iR2270/iR2870 (FAX)

imageRUNNER 3300/2800/2200 Canon iR2200-3300 (FAX)

imageRUNNER 3300i Canon iR2200-3300 (FAX)

imageRUNNER 3320G Canon iR2220/iR3320 (FAX)

imageRUNNER 3320i/2220i Canon iR2220/iR3320 (FAX)

imageRUNNER 3320N/2220N Canon iR2220/iR3320 (FAX)

imageRUNNER 3530 Canon iR3530 (FAX)

imageRUNNER 400/330 Canon iR330-400 PCL (FAX)

imageRUNNER 400/330 with Network 
Multi-PDL Printer Board-P1

Canon iR330-400-P1/R1 PCL (FAX)

imageRUNNER 400/330 with Network 
Multi-PDL Printer Board-R1

Canon iR330-400-P1/R1 PCL (FAX)

imageRUNNER 4570/3570 Canon iR3570/iR4570 (FAX)

imageRUNNER 4570G/3570G Canon iR3570/iR4570 (FAX)

imageRUNNER 5070 Canon iR5070 (FAX)

imageRUNNER 6570/5570 Canon iR5570/iR6570 (FAX)

imagePASS-M3 (iR6570/5570-M3) Canon iR5570/iR6570-M3 (FAX)

imageCLASS 2300 Canon iC2300 (FAX)

LASER CLASS 510 Canon LASER CLASS 500 (FAX)

LASER CLASS 700 series Canon LC700 (FAX)

MF7280 Canon MF7200 series (FAX)

Printer Name Driver Name
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IMPORTANT
 

• The fax options are available only if a fax board is installed in your printer.

• The LASER CLASS 510 supports only Windows 98/Me/2000/XP/Server 2003.

• In this guide, these printer names are hereafter referred to as the following:
- imagePASS-C1 (Color iR C2620-C1): Color imageRUNNER C2620-C1

- imagePASS-C1 (Color iR C3200-C1): Color imageRUNNER C3200-C1

- imagePASS-C1 (Color iR C3220-C1): Color imageRUNNER C3220-C1
- imagePASS-C2 (Color iR C2620-C2): Color imageRUNNER C2620-C2

- imagePASS-C2 (Color iR C3220-C2): Color imageRUNNER C3220-C2

- imagePASS-D1 (iR C5800-D1): imageRUNNER C5800-D1
- imagePASS-D1 (iR C6800-D1): imageRUNNER C6800-D1

- imagePASS-E1 (iR C3100-E1): imageRUNNER C3100-E1

- imagePASS-G1 (iR C5870-G1): imageRUNNER C5870-G1
- imagePASS-G1 (iR C6870-G1): imageRUNNER C6870-G1

- imagePASS-M3 (iR6570/5570-M3): imageRUNNER 6570/5570-M3

- imageRUNNER C3170i: imageRUNNER C3170
- imageRUNNER C3170U: imageRUNNER C3170

- imageRUNNER C5870U: imageRUNNER C5870

- imageRUNNER C6870U: imageRUNNER C6870
- imageRUNNER 400/330 with Network Multi-PDL Printer Board-P1 and R1: 

imageRUNNER 400/330-P1/R1
Introduction1-4
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The fax driver can be used in the following system environments:

■ Operating System Software
• Microsoft Windows 98

• Microsoft Windows Me
• Microsoft Windows NT 4.0

• Microsoft Windows 2000

• Microsoft Windows XP
• Microsoft Windows Server 2003

■ With a Server-Based Computing Environment
• Compatible Windows Terminal Server (Service)

- Microsoft Windows NT 4.0 Terminal Server Edition

- Microsoft Windows 2000 Server

- Microsoft Windows Server 2003
• Compatible Software

- Citrix MetaFrame XP

- Citrix MetaFrame 1.8
- Citrix MetaFrame Presentation Server 3.0

- Citrix Presentation Server 4.0
System Requirements 1-5
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■ Computer
Any computer which runs the above operating system software properly

IMPORTANT
 

If you are using the Color imageRUNNER C2620-C1, Color imageRUNNER C2620-C2, 
Color imageRUNNER C3200-C1, Color imageRUNNER C3220-C1, Color 
imageRUNNER C3220-C2, imageRUNNER C3100-E1, imageRUNNER C5800-D1, 
imageRUNNER C5870-G1, imageRUNNER C6800-D1, imageRUNNER C6870-G1, 
imageRUNNER 400/330, imageRUNNER 400/330-P1/R1, or imageRUNNER 6570/
5570-M3, after selecting a port, you need to specify a queue as described below. (You 
cannot specify <Direct> as the queue for the imageRUNNER 400/330.)

- LPR
For Windows TCP/IP, enter either <Print>, <Hold>, or <Direct> as the queue.

- RAW
The following four port numbers are available:
9100: Enter either <Print>, <Hold>, or <Direct> as the queue.
9101: The queue will be set to <Direct>.
9102: The queue will be set to <Print>.
9103: The queue will be set to <Hold>.

- SMB
Select any of the three queues displayed after selecting a printer from the network tree.
System Requirements1-6
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Here is where to get immediate help if you are having problems installing or using 
the fax driver.

■ README. TXT file
Any hints, enhancements, limitations, and restrictions you need to be aware of when 
installing and using your fax driver are included in the README.TXT file provided with the 
driver. This file is located in \FAX\us_eng.

■ Online Help
You can locate additional help for questions you may have regarding your fax in the Online 
Help file provided with the driver. In the fax properties dialog box, you can click [Help] to 
display additional information about every feature and option in the fax driver. You can 
also click [ ] (Help) in the upper right corner of most dialog boxes, and then click a 
specific item in the dialog box for help on that item.

■ Canon Authorized Dealers or Service Providers
If the Online Help file does not provide the information you need, contact your local 
authorized Canon dealer or service provider.
Where to Find Help 1-7
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Installing the Software
This section describes instructions for installing the software.

 

Installing the Fax Driver
Before using the fax function on your printer, you must install the fax driver for it.

Refer to the figure below in order to decide which procedure to use and read the 
corresponding pages in this manual.

With the Installer

To automatically find 
a network printer port

See "Dynamic Installation," 
on p. 2-11.

To configure a USB 
printer port in a USB 
driver installed 
environment

See "USB Installation Using 
the Add Printer Wizard," on 
p. 2-23.

To configure a USB 
printer port

See "USB Standard Installation   
(Windows 98/Me/2000/XP/
Server 2003)," on p. 2-22 of 
"USB Connection Installation 
(Windows 98/Me/2000/XP/
Server 2003)."

To manually configure  
the printer port 

See "Standard Installation," 
on p. 2-3.

Without the Installer
To install the printer 
driver for a local or 
network printer

See "Using the Add Printer 
Wizard," on p. 2-20.

To install the printer 
driver through a USB 
connection

Depending on your OS, see 
"Plug and Play Installation" 
(p. 2-24 to p. 2-36) of "USB 
Connection Installation  
(Windows 98/Me/2000/XP/
Server 2003)."
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IMPORTANT
 

• For Windows NT 4.0/2000/XP/Server 2003, log on as the Administrator when you install 
the driver.

• If you use the Installer, you can also update existing drivers simultaneously while 
installing a new driver, or update existing drivers without installing a new driver. Canon 
machines whose fax drivers can be updated are listed under "Supported Canon 
Products," on p. 1-2.

Standard Installation
Standard installation is when you select an existing printer port manually.

You can also install a network printer or set up a shared printer by following the 
procedure below.

NOTE
 

If you are using a printer connected to a network using TCP/IP protocol, you can 
automatically search for a port to install the fax driver. For instructions, see "Dynamic 
Installation," on p. 2-11.

1 Insert the Fax Driver Software CD-ROM into the CD-ROM 
drive.

2 Double-click the [My Computer] icon ➞ the CD-ROM drive 
icon.

3 Double-click the following folders: [FAX] ➞ [us_eng].

4 Double-click the [Setup.exe] icon to start the installation 
process.
Installing the Software 2-3
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5 In the first dialog box of the Fax Driver Setup Wizard, click 
[Next].

The [License Agreement] dialog box is displayed.

6 Read the license agreement carefully. If you agree to the terms 
➞ click [Yes].

7 Select [Manually Set Port to Install] ➞ click [Next].
Installing the Software2-4
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NOTE
 

If you have installed Canon Driver Information Assist Service and are using an 
operating system equipped with Windows Firewall, when the following message 
box is displayed, click [Yes] or [No].

- If you select [Yes], Windows Firewall will be configured to unblock the connection 
for Canon Driver Information Assist Service, so that you can set up the 
configuration automatically or use the Job Accounting feature.

- If you select [No], you cannot use Canon Driver Information Assist Service.

8 Click [Next]. 
Installing the Software 2-5
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If the required drivers have already been installed using the installer, the 
following screen is displayed. Select an option under [Process to Install Fax 
Driver] ➞ click [Next].

[Process to Install Fax Driver]
- [Add Faxes and Update Existing Drivers]: You can install a new driver and 

update existing drivers simultaneously.
- [Add Faxes]: You can add a new driver without affecting existing drivers.
- [Update Existing Drivers]: You can update the existing drivers already installed 

without having to add a new one. To do this, see "Updating the Existing Fax 
Drivers," on p. 2-39.

If you want to install the Canon Driver Information Assist Service together with the 
fax driver, also select [Canon Driver Information Assist Service].
Installing the Software2-6



2

G
et

tin
g 

S
ta

rt
ed
NOTE
 

• If you are using a shared fax in the Print Server (Point and Print) environment, it is 
necessary to install the Canon Driver Information Assist Service in the server PC in 
order to set up the fax configuration automatically or to use the Job Accounting 
feature.

• If the Canon Driver Information Assist Service is already installed on your 
computer, [Canon Driver Information Assist Service] does not display.

• If you are using an operating system equipped with Windows Firewall, when the 
following message box is displayed, click [Yes] or [No].

- If you select [Yes], Windows Firewall will be configured to unblock the connection 
for Canon Driver Information Assist Service, so that you can set up the 
configuration automatically or use the Job Accounting feature.

- If you select [No], you cannot use Canon Driver Information Assist Service.

9 Select the fax driver(s) you want to install from [Fax List] ➞ 
click [Add].

The fax driver(s) you selected is added to [Fax List for Driver Installation].
Installing the Software 2-7
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NOTE
 

To delete a fax driver that you do not want to install from [Fax List for Driver 
Installation], select the appropriate fax driver ➞ click [Remove].

10 Verify that the fax driver(s) you want to install is selected in 
the [Fax List for Driver Installation] ➞ click [Next].

11 Select a port.
Installing the Software2-8
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NOTE
 

• If more than one fax driver is selected, this dialog box will reappear to enable 
selection of different ports for other fax drivers.

• If you are using the Color imageRUNNER C2620-C1, Color imageRUNNER 
C2620-C2, Color imageRUNNER C3200-C1, Color imageRUNNER C3220-C1, 
Color imageRUNNER C3220-C2, imageRUNNER C3100-E1, imageRUNNER 
C5800-D1, imageRUNNER C5870-G1, imageRUNNER C6800-D1, 
imageRUNNER C6870-G1, or imageRUNNER 6570/5570-M3, only LPR, RAW, or 
SMB can be selected as the port. The machine is not compatible with NetWare and 
IPP.

● If you want to set a standard port:

❑ Select the printer port you want to use from [Port].

● If you want to set a port for a network printer:

❑ Click [Add Port].

❑ Select [Network] from [Add Port] dialog box ➞ click [OK].

❑ Select the network printer ➞ click [OK].
Installing the Software 2-9
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● If you want to add a port:

❑ Click [Add Port].

❑ Select the printer port you want to add from [Add Port] dialog box ➞ click [OK]. 

Ports displayed in the [Add Port] dialog box vary depending on the operating 
system you are using.

❑ Specify the settings for the port you want to add in the dialog box displayed ➞ 
click [OK].

12 Enter a fax name in [Fax Name] if necessary ➞ select [Set as 
Default] if you want to set the fax as the default printer ➞ click 
[Next].
Installing the Software2-10
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NOTE
 

• If you want to specify shared fax settings, or are installing an alternate driver in 
Windows NT 4.0/2000/XP/Server 2003, select [Use as Shared Fax]. For 
instructions on how to specify detailed settings for a shared fax, see steps 2 to 4 of 
"Alternate Fax Driver (Windows NT 4.0/2000/XP/Server 2003)," on p. 2-18.

• If you have selected [Network] in the [Add Port] dialog box, you cannot set [Fax 
Name] and [Use as Shared Fax].

13 Verify the installation settings ➞ click [Start].

14 After the files are copied, click [Exit] to finish the installation.

If you want to restart your computer, select [Restart My Computer Now].

The printer icon is displayed in the [Printers] folder. The driver is now installed.

Dynamic Installation
If you are using a printer connected to a network using TCP/IP protocol, you can 
automatically search for its printer port. To install the fax driver by dynamic 
installation, follow the procedure below. 

IMPORTANT
 

You can search only for printers in the same subnet as your computer.

NOTE
 

• If you are using a local printer or a printer connected to a network using a protocol other 
than TCP/IP, see "Standard Installation," on p. 2-3.

• Dynamic Installation is not available for the LASER CLASS 510, because this model 
does not come with a network interface.

The information 
shown in the 
window may differ 
according to your 
system 
parameters.
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1 Insert the Fax Driver Software CD-ROM into the CD-ROM 
drive.

2 Double-click the [My Computer] icon ➞ the CD-ROM drive 
icon.

3 Double-click the following folders: [FAX] ➞ [us_eng].

4 Double-click the [Setup.exe] icon to start the installation 
process.

5 In the first dialog box of the Fax Driver Setup Wizard, click 
[Next].

The [License Agreement] dialog box is displayed.

6 Read the license agreement carefully. If you agree to the terms 
➞ click [Yes].
Installing the Software2-12
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7 Select [Search for Network Faxes to Install] ➞ click [Next].

NOTE
 

• To search for faxes in sleep mode on the network, select [Reactive Faxes in the 
Sleep Mode and Search].

• If you have installed Canon Driver Information Assist Service and are using an 
operating system equipped with Windows Firewall, when the following message 
box is displayed, click [Yes] or [No].

- If you select [Yes], Windows Firewall will be configured to unblock the connection 
for Canon Driver Information Assist Service, so that you can set up the 
configuration automatically or use the Job Accounting feature.

- If you select [No], you cannot use Canon Driver Information Assist Service.
Installing the Software 2-13
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8 Click [Next].

If the required drivers have already been installed using the installer, the 
following screen is displayed. Select an option under [Process to Install Fax 
Driver] ➞ click [Next].

[Process to Install Fax Driver]
- [Add Faxes and Update Existing Drivers]: You can install a new driver and 

update existing drivers simultaneously.
- [Add Faxes]: You can add a new driver without affecting existing drivers.

If you want to install the Canon Driver Information Assist Service together with the 
fax driver, select [Canon Driver Information Assist Service] ➞ click [Next].
Installing the Software2-14
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NOTE
 

• If you are using a shared fax in the Print Server (Point and Print) environment, it is 
necessary to install the Canon Driver Information Assist Service in the server PC in 
order to set up the fax configuration automatically or to use the Job Accounting 
feature.

• If the Canon Driver Information Assist Service is already installed on your 
computer, [Canon Driver Information Assist Service] does not display.

• If you are using an operating system equipped with Windows Firewall, when the 
following message box is displayed, click [Yes] or [No].

- If you select [Yes], Windows Firewall will be configured to unblock the connection 
for Canon Driver Information Assist Service, so that you can set up the 
configuration automatically or use Job Accounting feature.

- If you select [No], you cannot use Canon Driver Information Assist Service.

9 Select the fax driver(s) you want to install from [Fax List] ➞ 
click [Add].

If you want to select all the fax drivers found, click [Select All].

If the Fax List is not displayed, click [Search Again].
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The fax driver(s) you selected is added to [Fax List for Driver Installation]. 

NOTE
 

• To delete a fax driver that you do not want to install from [Fax List for Driver 
Installation], select the appropriate fax driver ➞ click [Remove].

• If the appropriate fax machine cannot be found, refer to "Standard Installation," on 
p. 2-3, to install the fax driver.

10 Check that the fax driver(s) you want to install is selected in 
the [Fax List for Driver Installation] dialog box.

11 If you want to specify the fax settings, including the name or 
default fax setting, select [Set Fax Information] ➞ click [Next].

If you do not want to specify these settings, click [Next] ➞ skip to step 13.
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12 Enter a fax name in [Fax Name] if necessary ➞ select [Set as 
Default] if you want to set the fax as the default printer ➞ click 
[Next].

NOTE
 

If you want to specify shared fax settings, or are installing an alternate driver in 
Windows NT 4.0/2000/XP/Server 2003, select [Use as Shared Fax]. For 
instructions on how to specify detailed settings for a shared fax, see steps 2 to 4 of 
"Alternate Fax Driver (Windows NT 4.0/2000/XP/Server 2003)," on p. 2-18.

13 Verify the installation settings ➞ click [Start].

The information 
shown in the 
window may differ 
according to your 
system 
parameters.
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14 After the files are copied, click [Exit] to finish the installation.

If you want to restart your computer, select [Restart My Computer Now].

The printer icon is displayed in the [Printers] folder. The driver is now installed.

Alternate Fax Driver (Windows NT 4.0/2000/XP/Server 2003)
If you are using one or more shared printers in Windows NT 4.0/2000/XP/Server 
2003, you can install an alternate fax driver. Installing an alternate fax driver 
enables you to install a fax driver on a client PC via a network.

To specify settings for the shared fax, follow the procedure below.

1 Start the Installer ➞ follow the instructions in the dialog 
boxes.

See steps 1 to 11 of "Standard Installation," on p. 2-3.

2 Select [Use as Shared Fax] ➞ enter a share name. 

If you want to set the operating system on which the driver will run, click [Drivers 
to Add].
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3 Select operating system from [Drivers to Add] ➞ click [OK].

4 In the [Fax Information] dialog box, click [Next].

5 Follow the instructions in the dialog or message boxes to 
complete the installation.

See steps 13 to 14 of "Standard Installation," on p. 2-3.

IMPORTANT
 

To use the fax driver on the client PC, double-click the shared printer icon for the 
alternate fax driver on the server PC.
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Using the Add Printer Wizard
To install a fax driver from the [Printers] folder in the Windows Control Panel, follow 
the procedure below. 

1 On the [Start] menu, point to [Settings] ➞ click [Printers].

NOTE
 

• If you are using Windows XP Professional/Server 2003, on the [Start] menu, click 
[Printers and Faxes].

• If you are using Windows XP Home Edition, on the [Start] menu, click [Control 
Panel] ➞ [Printers and Other Hardware] ➞ [Printers and Faxes].

2 In the [Printers] folder, double-click the [Add Printer] icon to 
start the Add Printer Wizard ➞ follow the instructions on the 
screen to continue the installation.

3 Insert the Fax Driver Software CD-ROM into the CD-ROM drive 
➞ click [Have Disk].
Installing the Software2-20
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4 Click [Browse] to select the folder of the driver you want to 
install ➞ click [OK].

You can select the driver from the following folders on the CD-ROM:

5 Select your fax model from [Printers] ➞ click [Next].

6 Follow the instructions on the screen to continue ➞ click 
[Finish] to start copying the files.

The printer icon is displayed in the [Printers] folder. The driver is now installed. 

OS Path

Windows 98/Me: \FAX\us_eng\win98_me

Windows NT 4.0: \FAX\us_eng\winnt40

Windows 2000/XP/Server 2003: \FAX\us_eng\win2k_xp
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USB Connection Installation (Windows 98/Me/2000/XP/
Server 2003)

If your printer supports a USB port, you can send faxes via the USB port. The 
following fax driver installation methods enable you to do so.

■ If a USB driver has been installed on your computer:
If you have performed a USB installation using the Canon PCL5c, PCL5e, PCL6, PS, 
UFR, or UFR II printer driver on your computer, the USB driver has already been installed. 
In this case, you can install the fax driver by following either the standard installation or the 
Add Printer Wizard procedure.

■ If a USB driver has not been installed on your computer:
Install the USB driver and the fax driver according to the Plug and Play procedure.

NOTE
 

• If you are using the Color imageRUNNER C2620, Color imageRUNNER C3200, Color 
imageRUNNER C3220, imageRUNNER C3100, imageRUNNER C3170, imageRUNNER 
C5800, imageRUNNER C6800, imageRUNNER 2016, imageRUNNER 2020, 
imageRUNNER 2230, imageRUNNER 2830, imageRUNNER 2870/2270, 
imageRUNNER 2870G/2270G, imageRUNNER 3530, imageRUNNER 4570/3570, 
imageRUNNER 4570G/3570G, imageRUNNER 5070, imageRUNNER 6570/5570, 
LASER CLASS 510, or MF7280, you can fax in a USB environment. However, you 
cannot set up the fax configuration automatically or use the Job Accounting feature in a 
USB environment.

• If you are using an operating system equipped with Windows Firewall, the Found New 
Hardware Wizard may be displayed during installation. In this case, select [No, not this 
time] ➞ click [Next] ➞ install the USB driver and fax driver according to the Plug and Play 
procedure.

USB Standard Installation (Windows 98/Me/2000/XP/Server 2003)

1 Start the Installer ➞ follow the instructions in the dialog 
boxes.

See steps 1 to 10 of "Standard Installation," on p. 2-3.
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2 Select [Use Standard Port] from [Port Settings] ➞ click 
[Settings].

3 Select the USB port from the list ➞ click [OK].

4 In the [Fax Driver Setup Wizard] dialog box, click [Next].

5 Follow the instructions in the dialog box or message boxes to 
complete the installation.

See steps 13 to 14 of "Standard Installation," on p. 2-3.

USB Installation Using the Add Printer Wizard (Windows 98/Me/2000/
XP/Server 2003)

1 On the [Start] menu, point to [Settings] ➞ click [Printers].

NOTE
 

• If you are using Windows XP Professional/Server 2003, on the [Start] menu, click 
[Printers and Faxes].

• If you are using Windows XP Home Edition, on the [Start] menu, click [Control 
Panel] ➞ [Printers and Other Hardware] ➞ [Printers and Faxes].
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2 In the [Printers] folder, double-click the [Add Printer] icon to 
start the Add Printer Wizard ➞ follow the instructions on the 
screen to continue the installation.

3 When the port setting screen is displayed, select the USB 
port.

4 Follow the instructions in the dialog box or message boxes to 
complete the installation.

See steps 3 to 6 of "Using the Add Printer Wizard," on p. 2-20.

Plug and Play Installation (Windows 98)

1 Connect the cable from the printer's USB port to the PC's USB 
port, and then turn the printer ON.

2 Start Windows, and then insert the Fax Driver Software 
CD-ROM into the CD-ROM drive.

The Add New Hardware Wizard starts.

3 In the first dialog box of the Add New Hardware Wizard, click 
[Next].
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4 Select [Search for the best driver for your device. 
(Recommended)] ➞ click [Next].

5 Select [Specify a location] ➞ click [Browse] to select 
[\FAX\us_eng\usbport\win98] on the CD-ROM ➞ click [Next].

6 Follow the instructions on the screen ➞ click [Finish] after the 
files are copied.

The USB driver is now installed. The Add New Hardware Wizard restarts. 
Continue with the installation to install the fax driver.

7 In the first dialog box of the Add New Hardware Wizard, click 
[Next].
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8 Select [Display a list of all the drivers in a specific location, so 
you can select the driver you want] ➞ click [Next] ➞ follow the 
instructions on the screen.

9 Click [Have Disk].

10 Click [Browse] to select the folder containing the driver you 
want to install ➞ click [OK].
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You can select the driver from the following folder on the CD-ROM:

\FAX\us_eng\win98_me

11 Select your fax model from [Models] ➞ follow the instructions 
on the screen ➞ click [Finish] after the files are copied.

The fax driver is now installed.

Plug and Play Installation (Windows Me)

1 Connect the cable from the printer's USB port to the PC's USB 
port, and then turn the printer ON.

2 Start Windows, and then insert the Fax Driver Software 
CD-ROM into the CD-ROM drive.

The Add New Hardware Wizard starts.
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3 In the first dialog box of the Add New Hardware Wizard, select 
[Automatic search for a better driver (Recommended)] ➞ click 
[Next].

4 Select the [FXUUSBME.INF] file in the [Select Other Driver] 
dialog box ➞ click [OK].

5 Follow the instructions on the screen ➞ click [Finish] after the 
files are copied.

The USB driver is now installed. The Add New Hardware Wizard restarts. 
Continue with the installation to install the fax driver.

6 In the first dialog box of the Add New Hardware Wizard, click 
[Next].
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7 Select [Specify the location of the driver (Advanced)] ➞ click 
[Next].

8 Select [Display a list of all drivers in a specific location, so you 
can select the driver you want] ➞ click [Next].

9 Select [Printer] as the device type ➞ click [Next].

10 Click [Have Disk].

11 Click [Browse] to select the folder containing the driver you 
want to install ➞ click [OK].

You can select the driver from the following folder on the CD-ROM:

\FAX\us_eng\win98_me
Installing the Software 2-29



2

G
et

tin
g 

S
ta

rt
ed
12 Select your fax model from [Models] ➞ follow the instructions 
on the screen ➞ click [Finish] after the files are copied.

The fax driver is now installed.

Plug and Play Installation (Windows 2000)

1 Connect the cable from the printer's USB port to the PC's USB 
port, and then turn the printer ON.

2 Start Windows, and then insert the Fax Driver Software 
CD-ROM into the CD-ROM drive.

The Found New Hardware Wizard starts.

3 In the first dialog box of the Found New Hardware Wizard, 
click [Next].
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4 Select [Display a list of the known drivers for this device so 
that I can choose a specific driver] ➞ click [Next].

5 Select [Printers] from [Hardware types] ➞ click [Next].

6 Click [Have Disk].
Installing the Software 2-31



2

G
et

tin
g 

S
ta

rt
ed
7 Click [Browse] to select the folder containing the driver you 
want to install ➞ click [OK].

You can select the driver from the following folder on the CD-ROM:

\FAX\us_eng\win2k_xp

8 Select your fax model from [Printers] ➞ follow the instructions 
on the screen ➞ click [Finish] after the files are copied.

The fax driver is now installed.
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Plug and Play Installation (Windows XP/Server 2003)

1 Connect the cable from the printer's USB port to the PC's USB 
port, and then turn the printer ON.

2 Start Windows, and then insert the Fax Driver Software 
CD-ROM into the CD-ROM drive.

The Found New Hardware Wizard starts.

NOTE
 

If you are using an operating system with Windows Firewall, the following dialog 
box may be displayed. In this case, select [No, not this time] ➞ click [Next] to 
proceed to step 3.
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3 Select [Install from a list or specific location (Advanced)] ➞ 
click [Next].

4 Select [Don't search. I will choose the driver to install] ➞ click 
[Next].

5 Select [Printer] from [Hardware types] ➞ click [Next].
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6 Click [Have Disk].

7 Click [Browse] to select the folder containing the driver you 
want to install ➞ click [OK].

You can select the driver from the following folder on the CD-ROM:

\FAX\us_eng\win2k_xp
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8 Select your fax model from [Printers] ➞ follow the instructions 
on the screen ➞ click [Finish] after the files are copied.

The fax driver is now installed.

 

Installing the Canon Driver Information Assist Service
After installing the fax driver, you can setup the fax configuration automatically and 
use the Job Accounting feature. If you are using a shared fax in the Print Server 
(Point and Print) environment, it is necessary to install the Canon Driver Information 
Assist Service in the server PC.

If the software is not installed in your computer, follow the procedure below to install 
it.

1 Insert the Fax Driver Software CD-ROM into the CD-ROM 
drive.

2 Double-click the [My Computer] icon ➞ the CD-ROM drive 
icon.

3 Double-click the following folders: [FAX] ➞ [us_eng].

4 Double-click the [Setup.exe] icon to start the installation 
process.
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5 In the first dialog box of the Fax Driver Setup Wizard, click 
[Next].

The [License Agreement] dialog box is displayed.

6 Read the license agreement carefully. If you agree to the terms 
➞ click [Yes].

7 Select [Manually Set Port to Install] ➞ click [Next].
Installing the Software 2-37



2

G
et

tin
g 

S
ta

rt
ed
8 Select [Canon Driver Information Assist Service] ➞ click 
[Next].

NOTE
 

If you are using an operating system equipped with Windows Firewall, when the 
following message box is displayed, click [Yes] or [No].

- If you select [Yes], Windows Firewall will be configured to unblock the connection 
for Canon Driver Information Assist Service, so that you can set up the 
configuration automatically or use the Job Accounting feature.

- If you select [No], you cannot use Canon Driver Information Assist Service.

9 After the files are copied, click [Exit] to finish the installation.

If you want to restart your computer, select [Restart My Computer Now].

The Canon Driver Information Assist Service is now installed.
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Updating the Existing Fax Drivers

IMPORTANT
 

Canon machines whose fax drivers can be updated using this version of the driver are 
listed under "Supported Canon Products," on p. 1-2.

Using the Installer
If you use the Installer to install new fax drivers, the Installer updates the existing 
ones at the same time that the new drivers are installed.

You can also update the existing drivers already installed without having to add a 
new driver by following the procedure below.

NOTE
 

You can also update an old version of the alternate printer driver simultaneously.

1 Start the Installer ➞ follow the instructions in the dialog 
boxes.

See steps 1 to 8 of "Standard Installation," on p. 2-3.

2 Select [Update Existing Drivers] ➞ click [Next].
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3 Verify the installation settings ➞ click [Start].

4 After the files are copied, click [Exit] to finish the installation.

Restart your computer when a message appears prompting you to do so.

The fax drivers already installed are now updated.

IMPORTANT
 

To use the updated alternate printer driver on the client PC, first uninstall the 
current printer driver ➞ double-click the shared printer icon for the updated 
alternate printer driver on the server PC.

Using the Add Printer Wizard

1 Insert the Fax Driver Software CD-ROM into the CD-ROM 
drive.

2 On the [Start] menu, point to [Settings] ➞ click [Printers].

NOTE
 

• If you are using Windows XP Professional/Server 2003, on the [Start] menu, click 
[Printers and Faxes].

• If you are using Windows XP Home Edition, on the [Start] menu, click [Control 
Panel] ➞ [Printers and Other Hardware] ➞ [Printers and Faxes].
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3 In the [Printers] folder, right-click the fax driver icon you want 
to update ➞ click [Properties].

4 Click the [Details] tab (Windows 98/Me), [General] tab 
(Windows NT 4.0), or [Advanced] tab (Windows 2000/XP/
Server 2003).

5 Click [New Driver] ➞ follow the instructions on the screen.

NOTE
 

For Windows NT 4.0, take note of the fax name displayed at the top of the [Details] 
sheet.
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6 Click [Have Disk] to specify the driver path on the CD-ROM ➞ 
follow the instructions on the screen.

If you are using Windows NT 4.0, proceed to step 7.

If you are using Windows 98/Me/2000/XP/Server 2003, skip to step 8.

For Windows 98/Me/2000/XP/Server 2003, the fax driver is updated.

7 If a message box appears asking whether you want to replace 
the existing driver, select [Replace existing driver] ➞ click 
[OK].

The fax driver is updated.

NOTE
 

Check whether the fax name has been changed. If so, rename the fax with its 
original name, which you have taken note of in step 5. For example, you may see 
the fax name being changed in the following way: from <Canon iR2200-3300 
(FAX)> to <Canon iR2200-3300 (FAX) (Copy 2)>.
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8 Repeat steps 1 to 7 for all other existing Canon fax drivers, if 
necessary.

9 Restart the computer.

10 Check the fax configuration settings in the [Configuration] 
sheet (for Windows 98/Me) or [Device Settings] sheet (for 
Windows NT 4.0/2000/XP/Server 2003), and then reconfigure 
them if they have been changed.

NOTE
 

• For the imageRUNNER 400/330 and imageRUNNER 400/330-P1/R1, 
[Configuration] sheet is displayed regardless of the operating system you are 
using.

• If you are using a shared fax in the Print Server (Point and Print) environment, it is 
necessary to install the Canon Driver Information Assist Service in the server PC in 
order to set up the fax configuration automatically or to use the Job Accounting 
feature. (See "Installing the Canon Driver Information Assist Service," on p. 2-36.)

 

Updating the Alternate Fax Driver (Windows NT 4.0/2000/
XP/Server 2003)

If you use a shared fax on a network, and an alternate fax driver is installed on the 
server, the alternate fax driver is updated simultaneously when you install a new 
driver with the Installer. To update the alternate fax driver manually without using 
the Installer, follow the procedure below.

Windows NT 4.0

1 On the [Start] menu, point to [Settings] ➞ click [Printers].

2 In the [Printers] folder, right-click the shared fax driver you 
want to update ➞ click [Properties].

3 In the fax properties dialog box, click the [Sharing] tab.
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4 Select the alternate fax driver you want to update from 
[Alternate Drivers] ➞ click [OK].

5 When a message appears prompting you to insert the 
CD-ROM, insert the Fax Driver Software CD-ROM into the 
CD-ROM drive ➞ click [OK].

6 Click [Browse] to specify the driver path in the CD-ROM ➞ 
click [OK].

The alternate fax driver is updated.

IMPORTANT
 

To use the updated fax driver on the client PC, first uninstall the current fax driver ➞ 
double-click the shared printer icon for the updated alternate fax driver on the 
server PC.
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Windows 2000/XP/Server 2003

1 On the [Start] menu, point to [Settings] ➞ click [Printers].

NOTE
 

• If you are using Windows XP Professional/Server 2003, on the [Start] menu, click 
[Printers and Faxes].

• If you are using Windows XP Home Edition, on the [Start] menu, click [Control 
Panel] ➞ [Printers and Other Hardware] ➞ [Printers and Faxes].

2 Click [Server Properties] on the [File] menu to open the [Print 
Server Properties] dialog box ➞ click the [Drivers] tab.

3 Select the alternate fax driver you want to update ➞ click 
[Update] (Windows 2000), [Replace] (Windows XP), or 
[Reinstall] (Windows Server 2003).

4 When a message appears prompting you to insert the 
CD-ROM, insert the Fax Driver Software CD-ROM into the 
CD-ROM drive ➞ click [OK].
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5 Click [Browse] to specify the driver path in the CD-ROM ➞ 
click [OK].

The alternate fax driver is updated.

IMPORTANT
 

To use the updated fax driver on the client PC, first uninstall the current fax driver ➞ 
double-click the shared fax icon for the updated alternate fax driver on the server 
PC.

 

Uninstalling the Fax Driver
It is recommended that you use the Uninstaller to uninstall an unnecessary driver.

1 On the [Start] menu, point to [Programs] ➞ [Canon Printer 
Uninstaller] ➞ click [Raster PCL5e Fax Driver Uninstaller].

2 In the [Delete Fax] dialog box, select the fax driver you want to 
delete.

3 Click [Delete].
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4 Click [Yes] to confirm the deletion.

5 Click [Exit] in the [Delete Fax] dialog box.

NOTE
 

You can also start the Uninstaller from the Fax Driver Software CD-ROM. To do so, 
double-click the [UNINSTAL.exe] icon in the following folder:
\FAX\us_eng\misc
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Specifying the Installed Optional Fax Board
Before sending a document by fax, you may need to specify the optional fax board 
installed in your fax.

The fax configuration can be setup automatically while installing the driver, 
depending on the port selected for the machine. If the machine cannot be 
configured automatically, follow the procedure below in order to do it manually.

NOTE
 

• A fax board can be specified for the imageRUNNER C3170, imageRUNNER 2010F, 
imageRUNNER 2870/2270, imageRUNNER 2870G/2270G, imageRUNNER 4570/3570, 
imageRUNNER 4570G/3570G, imageRUNNER 5070, imageRUNNER 6570/5570, and 
LASER CLASS 700 series.

• You can specify the line to use for fax transmission after specifying the optional fax board.

1 On the [Start] menu, point to [Settings] ➞ click [Printers].

NOTE
 

• If you are using Windows XP Professional/Server 2003, on the [Start] menu, click 
[Printers and Faxes].

• If you are using Windows XP Home Edition, on the [Start] menu, click [Control 
Panel] ➞ [Printers and Other Hardware] ➞ [Printers and Faxes].

2 In the [Printers] folder, right-click the printer icon for your fax 
➞ click [Properties].
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3 In the fax properties dialog box, click the [Configuration] tab 
(for Windows 98/Me) or [Device Settings] tab (for Windows NT 
4.0/2000/XP/Server 2003).

The [Configuration] sheet (for Windows 98/Me) or [Device Settings] sheet (for 
Windows NT 4.0/2000/XP/Server 2003) is displayed.

NOTE
 

For the imageRUNNER 400/330 and imageRUNNER 400/330-P1/R1, 
[Configuration] sheet is displayed regardless of the operating system you are 
using.

4 Select an optional fax board from [Fax Board Options].

5 Click [OK].

The installed optional fax board is specified.
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NOTE
 

• After the optional fax board is selected, set the telephone line for fax transmission 
from [Line Selection] in the [Special] sheet.

• Clicking [Get Device Status] automatically specifies the optional fax board. If you 
are using a shared fax in the Print Server (Point and Print) environment, however, it 
is necessary to install the Canon Driver Information Assist Service in the server PC 
in order to set up the fax configuration automatically by clicking [Get Device 
Status]. (See "Installing the Canon Driver Information Assist Service," on p. 2-36.)

• If you are using a local fax (connected to an LPT port, USB port, etc.), you cannot 
set up the fax configuration automatically.
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Before sending a document by fax, you need to specify the amount of fax memory.

NOTE
 

• Fax memory can be specified for the imageRUNNER 400/330 and imageRUNNER 400/
330-P1/R1.

• The number of recipients to which you can send simultaneously depends on the fax 
memory.

1 On the [Start] menu, point to [Settings] ➞ click [Printers].

NOTE
 

• If you are using Windows XP Professional/Server 2003, on the [Start] menu, click 
[Printers and Faxes].

• If you are using Windows XP Home Edition, on the [Start] menu, click [Control 
Panel] ➞ [Printers and Other Hardware] ➞ [Printers and Faxes].

2 In the [Printers] folder, right-click the printer icon for your fax 
➞ click [Properties].
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3 In the fax properties dialog box, click the [Configuration] tab 
(for Windows 98/Me) or [Device Settings] tab (for Windows NT 
4.0/2000/XP/Server 2003).

The [Configuration] sheet (for Windows 98/Me) or [Device Settings] sheet (for 
Windows NT 4.0/2000/XP/Server 2003) is displayed.

NOTE
 

For the imageRUNNER 400/330 and imageRUNNER 400/330-P1/R1, 
[Configuration] sheet is displayed regardless of the operating system you are 
using.

4 Select the amount of memory from [FAX Memory].

5 Click [OK].

The installed memory size is specified.
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Faxing a Document
This section describes how to fax a document and how to send a document to the 
memory box of the recipient's fax.

 

Sending a Document
To send a document by fax, follow the procedure below.

1 In application software, with the document open, select 
[Print].

2 In the [Print] dialog box, select your fax from [Name] ➞ click 
[Properties].

The fax properties dialog box opens.

NOTE
 

Some application software may have a different method with which to select a fax 
driver.
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3 Specify the various settings in the [Edit Address Book], 
[Register Cover Sheet], and [Special] sheets ➞ click [OK].

4 Click [OK] in the [Print] dialog box.

The [Fax Sending Settings] dialog box opens.
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5 In the [Sending Settings] sheet, specify the name and fax 
number of the fax recipient ➞ click [Add to Recipient List].

6 Click the [Cover Sheet] tab ➞ specify a format for the cover 
sheet attachment.
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7 Click [OK] in the fax properties dialog box.

The fax is sent to the specified recipient(s).

NOTE
 

For the Color imageRUNNER C2620-C1, Color imageRUNNER C2620-C2, Color 
imageRUNNER C3200-C1, Color imageRUNNER C3220-C1, Color 
imageRUNNER C3220-C2, imageRUNNER C3100-E1, imageRUNNER 
C5800-D1, imageRUNNER C5870-G1, imageRUNNER C6800-D1, 
imageRUNNER C6870-G1, or imageRUNNER 6570/5570-M3, print jobs sent from 
the fax driver are not recorded on the controller job log.

 

Sending to a Remote Memory Box
This mode is useful for sending a confidential document by fax. Documents that are 
to be sent and stored in the memory box of the recipient's fax require a valid 
subaddress and password.

NOTE
 

• Obtain the subaddress and password of the memory box of the recipient's fax from the 
recipient.

• This function is not available for the imageRUNNER 2016, imageRUNNER 2020, 
imageRUNNER 400/330, imageRUNNER 400/330-P1/R1, LASER CLASS 510, and 
MF7280.

1 In application software, with the document open, select 
[Print].

2 In the [Print] dialog box, select your fax name from [Name] ➞ 
click [Properties].

The fax properties dialog box opens.

NOTE
 

Some application software may have a different method for selecting a fax driver.
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3 Specify the various settings in the [Edit Address Book], 
[Register Cover Sheet], or [Special] sheet ➞ click [OK].

4 Click [OK] in the [Print] dialog box.

The [Fax Sending Settings] dialog box opens.

5 In the [Sending Settings] sheet, specify the name and fax 
number of the recipient.
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6 Click [Settings].

7 Select [Use Subaddress] ➞ enter the subaddress and 
password of the memory box of the recipient's fax ➞ click 
[OK].

8 Click [Add to Recipient List].
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9 Click the [Cover Sheet] tab ➞ specify the format of the cover 
sheet attachment.

10 Click [OK] in the [Fax Sending Settings] dialog box.

The document is sent to and stored in the memory box of the recipient's fax. 

NOTE
 

The data can be output only if the correct password is specified on the recipient's 
fax.
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You can specify the names and fax numbers of people you want to send a fax to, by 
adding them to [Recipient List]. You can add recipients by:

• Entering a new name and a new fax number in [Recipient Name] and [Fax 
Number].

• Selecting a recipient in the [Select Recipient from Address Book] dialog box.

NOTE
 

For Windows NT 4.0/2000/XP/Server 2003, you can use or edit the Address Book only if 
you are permitted access to the folder where the Address Book file is saved (by default, 
Power Users and higher have access to the folder). If you are not permitted access to the 
folder, you can use the Address Book in one of the following ways:
- Log on as a user who has access to the folder.

- Click [Specify a Folder] in the [Edit Address Book] sheet, and save the Address Book 
file in a folder, such as the My Documents folder, where you have Write permission.
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Adding a New Name and Fax Number

1 From the [Fax Sending Settings] dialog box, display the 
[Sending Settings] sheet.

For details on how to access the [Fax Sending Settings] dialog box, see "Sending 
a Document," on p. 3-2.

2 Enter the name and fax number you want to add in [Recipient 
Name] and [Fax Number].

3 Click [Add to Recipient List].

The new recipient is displayed in [Recipient List].
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Adding a Recipient from the Address Book

1 From the [Fax Sending Settings] dialog box, display the 
[Sending Settings] sheet.

For details on how to access the [Fax Sending Settings] dialog box, see "Sending 
a Document," on p. 3-2.
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2 Click [Address Book].

The [Select Recipient from Address Book] dialog box opens.

3 Select the address book you want to use from [Address 
Books].

NOTE
 

If you want to use an address book other than Canon Fax Driver Address Book, 
register the book before using it. (See "Registering Additional Address Books," on 
p. 3-24.)

4 Select an entry ➞ click [Add to List].

5 Click [OK] in the [Select Recipient from Address Book] dialog 
box.

The new recipient is displayed in [Recipient List] in the [Sending Settings] sheet.
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This section describes instructions for defining person and group entries in the [Edit 
Address Book] sheet.

NOTE
 

For Windows NT 4.0/2000/XP/Server 2003, you can use or edit the Address Book only if 
you are permitted access to the folder where the Address Book file is saved (by default, 
Power Users and higher have access to the folder). If you are not permitted access to the 
folder, you can use the Address Book in one of the following ways:

- Log on as a user who has access to the folder.

- Click [Specify a Folder] in the [Edit Address Book] sheet, and save the Address Book 
file in a folder, such as the My Documents folder, where you have Write permission.

 

Person (Single) Entry
Clicking [Add Person] in the [Edit Address Book] sheet opens the [Add Person] 
dialog box for defining a new person (single) entry. You see the same dialog box 
under the title [Edit Person], if you click [Edit] in the [Edit Address Book] sheet when 
a person (single) entry is selected from [Address Book]. The [Edit Person] dialog 
box enables you to change information on an existing person (single) entry.
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New Entry

1 From the fax properties dialog box, display the [Edit Address 
Book] sheet.

For details on how to access the fax properties dialog box, see "Sending a 
Document," on p. 3-2.
Defining Address Book Entries3-14



3

Fa
x 

D
riv

er
 O

pt
io

ns
2 Click [Add Person].

The [Add Person] dialog box opens.

3 Enter information about the new person, such as [Recipient 
Name] and [Company].

4 Enter the fax number.

You can enter two fax numbers: a primary number and a secondary number.

5 Enter information about the fax numbers in each respective 
[Description].

6 If you want to send documents to the memory box of the 
recipient's fax, click [Settings].

If you do not want to use this option, skip to step 8.

NOTE
 

For the imageRUNNER 2016, imageRUNNER 2020, imageRUNNER 400/330, 
imageRUNNER 400/330-P1/R1, LASER CLASS 510, and MF7280, [Settings] is 
not displayed. If you are using one of these models, skip to step 8.
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7 Select [Use Subaddress for Primary Number] and/or [Use 
Subaddress for Secondary Number] ➞ enter the subaddress 
and the password of the recipient's fax ➞ click [OK].

NOTE
 

• Obtain the subaddress and password of the memory box of the recipient's fax from 
the recipient.

• You can leave the password blank if password is not registered at the recipient's 
fax.

8 Enter any additional information about the person in [Notes].

9 Click [OK] to create the new person (single) entry.

NOTE
 

If you specify two fax numbers for one person, two entries for that person are 
displayed in [Address Book].
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Edit Entry

1 From the fax properties dialog box, display the [Edit Address 
Book] sheet ➞ select [Person] from [Show].

For details on how to access the fax properties dialog box, see "Sending a 
Document," on p. 3-2.

All person (single) entries are displayed in [Address Book].
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2 Select the person you want to edit ➞ click [Edit].

The [Edit Person] dialog box opens.

3 Update the information if necessary. 

4 Click [OK] to modify the selected person (single) entry. 

Delete Entry

1 Select the person (single) entry you want to delete from 
[Address Book].

2 Click [Delete].
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Group Entry
Clicking [Add Group] in the [Edit Address Book] sheet opens the [Add Group] dialog 
box for defining a new group. A group can contain both persons and other groups. 
You see the same dialog box under the title [Edit Group], if you click [Edit] in the 
[Edit Address Book] sheet when a group entry is selected from Address Book.

The [Edit Group] dialog box enables you to change information on an existing group 
entry. 

New Group

1 From the fax properties dialog box, display the [Edit Address 
Book] sheet.

For details on how to access the fax properties dialog box, see "Sending a 
Document," on p. 3-2.
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2 Click [Add Group].

The [Add Group] dialog box opens.

3 Enter the new group name.

4 Select persons or groups as members of the new group from 
[Available Recipients] ➞ click [Add].

If you want to add a group to the new group, select [Group] or [All] from [Show] 
to view group entries.

To remove an entry from [Current Group Members], select it ➞ click [Delete].

NOTE
 

You can select multiple entries by holding down [SHIFT] or [CTRL] on the keyboard 
and clicking each entry that you want to select.

5 Click [OK] to create the new group entry.
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Edit Group

1 From the fax properties dialog box, display the [Edit Address 
Book] sheet ➞ select [Group] from [Show].

For details on how to access the fax properties dialog box, see "Sending a 
Document," on p. 3-2.

To view all person (single) and group entries, select [All] from [Show].

All group entries are displayed in [Address Book].
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2 Select the group you want to edit ➞ click [Edit].

The [Edit Group] dialog box opens.

3 Change the group name if necessary. 

4 Edit the group.

● To add a person or a group to the selected group:

❑ Select the person or group you want to add from [Available Recipients].

❑ Click [Add]. 

● To remove a member of the selected group:

❑ Select the person or group you want to remove from [Current Group Members].

❑ Click [Delete]. 

NOTE
 

You can select multiple entries by holding down [SHIFT] or [CTRL] on the keyboard 
and clicking each entry that you want to select.

5 Click [OK] to modify the selected group entry.
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Delete Group

1 Select the group entry you want to delete from [Address 
Book].

2 Click [Delete].
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Registering Additional Address Books
You can select fax recipients from address books other than the Canon Fax Driver 
Address Book if they are registered with the fax driver.  Follow the procedure below 
to register the address books you want to use.

NOTE
 

You can register the Messaging API Address Book and the Windows Address Book.

1 From the fax properties dialog box, click the [Special] tab.

For details on how to access the fax properties dialog box, see "Sending a 
Document," on p. 3-2.

2 Click [Address Books].

The [Address Books] dialog box opens.
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3 Click [Register].

The [Register Address Book] dialog box opens.

4 Select the address book you want to register from [Available 
Address Books] ➞ click [OK].

The dialog box corresponding to the selected address book opens.

5 Specify the required settings in the dialog box.

For detailed information about an item in the dialog box, click [ ] (Help) ➞ click 
the specific item in the dialog box you want to know about.
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6 Click [OK] in the dialog box.

The registered address book is added to [Address Book List] in the [Address 
Books] dialog box.

7 Click [OK] in the [Address Books] dialog box.
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This section describes instructions for attaching a cover sheet to an outgoing fax.

1 From the [Fax Sending Settings] dialog box, click the [Cover 
Sheet] tab.

For details on how to access the [Fax Sending Settings] dialog box, see "Sending 
a Document," on p. 3-2.

2 Select an option for attaching the cover sheet to the fax from 
[Cover Sheet Attachment].

3 Select a cover sheet template from [Style].

4 Click [Settings] to specify the items to include on the cover 
sheet.

The [Item Settings] dialog box opens.
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5 Display the [Sender] sheet ➞ select check boxes according to 
the information you want to print on the cover sheet ➞ enter 
the information in the text boxes for the selected items.

You can select the following check boxes:

• [Include Sender Name]
• [Include Company]
• [Include Dept./Div.]
• [Include Fax Number]

NOTE
 

You can save the information entered in the [Sender] sheet in a file by clicking 
[Save Sender]. Then, when you send a fax, you can import the information by using 
[Import Sender], instead of entering the sender information each time you send a 
fax.
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6 Click the [Recipient] tab ➞ select check boxes according to 
the information you want to print on the cover sheet.

You can select the following check boxes:

• [Include Recipient Name]
• [Include Company]
• [Include Dept./Div.]
• [Include Fax Number]

NOTE
 

The information of the recipients specified in the [Sending Settings] sheet prints on 
the cover sheet.
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7 Click the [Logo] or [Signature] tab.

8 Select [Print with Logo] or [Print with Signature] to include a 
logo or signature on the cover sheet.

9 Click [Browse] ➞ select a bitmap logo or signature file name in 
[File Name].

10 Specify the magnification and position of the selected logo or 
signature.
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11 Click the [Sheets to Send] tab ➞ select [Include Number of 
Sheets to Send] ➞ enter the number of sheets you are going 
to send as a fax.

12 Click [OK] in the [Item Settings] dialog box.

13 Select [Insert Attention Note] ➞ select a note from [Attention 
Note] or enter a note.

14 Enter any other information you want to include on the cover 
sheet in [Comment to Include].

15 Click [Preview] if you want to check the preview image on the 
cover sheet.

16 Click [OK].

The specified cover sheet is attached to the fax when the fax is sent.
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What Is the Cover Sheet Editor?
The Canon Cover Sheet Editor is software for creating original fax cover sheet 
templates for use with a Canon fax driver.

After registering cover sheets created with this software in your fax driver, you can 
use them with any fax. If you specify fields instead of manually entering data for 
sender or recipient information, the actual sender or recipient information that you 
select in the fax driver is automatically entered in the cover sheet when the fax is 
sent.

With the Canon Cover Sheet Editor, you can do the following:

• Insert text using different fonts, font styles, and font sizes into a cover sheet.

• Insert a variety of objects, such as drawings and images, into a cover sheet.

• Use the field feature for creating cover sheets for sending faxes to multiple 
recipients.

• Add fields for specifying remarks and comments in addition to the sender and 
recipient information fields.

• Easily edit the display order and position of objects, and group different objects.

• Align objects on a grid while you work with them.
What Is the Cover Sheet Editor?4-2
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This section describes how to install and uninstall the Canon Cover Sheet Editor.

 

Installation
To install the Canon Cover Sheet Editor, follow the procedure below.

1 Insert the Fax Driver Software CD-ROM into the CD-ROM 
drive.

2 Double-click the [My Computer] icon ➞ the CD-ROM drive 
icon.

3 Double-click the following folders: [FAX] ➞ [us_eng] ➞ [CSE].

4 Double-click the [setup] icon to start the installation process.

5 In the first dialog box of the Installer, click [Next] ➞ follow the 
instructions on the screen to continue the installation.
Installing the Cover Sheet Editor 4-3
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The [Canon Cover Sheet Editor License Agreement] dialog box is displayed.

6 Read the Canon Cover Sheet Editor license agreement 
carefully. If you agree to the terms, select [I accept the terms 
in the license agreement.] ➞ click [Next] ➞ follow the 
instructions on the screen to continue the installation.

7 In the dialog box for selecting a setup type, select [Complete] 
or [Custom] ➞ click [Next].

NOTE
 

If you select [Custom] in the dialog box for selecting [Setup Type], you can specify 
the directory into which the Canon Cover Sheet Editor is to be installed.
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8 Click [Install] to start copying the files.

 

Launching
To start the Cover Sheet Editor, follow the procedure below.

1 On the [Start] menu, point to [Programs] ➞ [Canon] ➞ [CSE] ➞ 
click [Cover Sheet Editor].

The Canon Cover Sheet Editor starts.
Installing the Cover Sheet Editor 4-5
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Uninstalling
If it becomes necessary to uninstall the Canon Cover Sheet Editor, follow the 
procedure below.

1 On the [Start] menu, point to [Settings] ➞ click [Control Panel].

2 Double-click the [Add/Remove Programs] icon ➞ select 
[Canon Cover Sheet Editor] ➞ click [Add/Remove].

3 When the [InstallShield Wizard] dialog box appears, follow the 
instructions on the screen.

The Canon Cover Sheet Editor is uninstalled.
Installing the Cover Sheet Editor4-6
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This section describes how to create, open, save, and close files.

 

Opening a File

Creating a New File
To create a new cover sheet, follow the procedure below.

1 Click [ ] (New) on the toolbar.

You can also select [New] from the [File] menu.

The [New] dialog box opens.

2 Select a paper size for the new cover sheet ➞ click [OK].

The New Cover Sheet screen appears.
Opening, Saving, and Closing a File 4-7
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Opening a Saved Cover Sheet
You can open a saved cover sheet by specifying its file name.

To open a saved cover sheet, follow the procedure below.

1 Click [ ] (Open) on the toolbar.

You can also select [Open] from the [File] menu.

The [Open] dialog box opens.

2 Specify the file name of the cover sheet that you want to open.

NOTE
 

Clicking [Preview] displays an image of the selected cover sheet.

3 Click [Open].

The selected cover sheet appears.

 

Saving and Closing a File

Saving a New File
If you save a cover sheet, you can register it later in the fax driver for use as an 
original cover sheet.

1 Click [ ] (Save) on the toolbar.

You can also select [Save] or [Save as] from the [File] menu.

The [Save as] dialog box opens.

2 Enter a name for the file in [File name] ➞ specify the location 
where you want to save the file ➞ click [Save].

The file extension is automatically set to ".cse".
Opening, Saving, and Closing a File4-8
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Saving an Existing File
Follow the procedure below to save an existing cover sheet after editing it.

1 Click [ ] (Save) on the toolbar.

You can also select [Save] from the [File] menu.

IMPORTANT
 

• To preserve the opened file as it was before editing, select [Save As] and specify a 
different name or location for saving the edited file. Selecting [Save] will overwrite 
the existing file.

• Selecting the [Save as] command is necessary only to specify a different file name 
or a different location to save the cover sheet.

Closing a File
Follow the procedure below to close a currently open cover sheet without exiting 
the Canon Cover Sheet Editor.

1 Click the lower [ ] (Close) at the top-right corner of the 
Canon Cover Sheet Editor main window.

You can also select [Close] from the [File] menu.

NOTE
 

If you close a cover sheet that has not been saved after editing, a message 
appears asking whether you want to save the changes. Click [Yes] to save the 
changes, or [No] if you do not want to save changes. Click [Cancel] if you do not 
want to close the cover sheet.
Opening, Saving, and Closing a File 4-9
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Creating an Original Cover Sheet
This section describes how to insert text, adjust text properties, specify fields, 
create objects, adjust objects, and specify grid options in order to create an original 
cover sheet.

 

Inserting Text
You can insert text and numbers into the cover page. The properties of any text or 
the text box itself can also be changed. To edit the text, change to the edit mode by 
clicking anywhere inside of a text box, and then place the cursor on the text that you 
want to edit.

1 Click [ ] (Text Box) on the toolbar.

You can also select [Text Box] from the [Insert] menu.

2 Drag the pointer on the area of the cover sheet to insert text.

A square or rectangular text box appears.

3 Click inside the text box.

The cursor for editing text appears.

4 Enter the desired text.
Creating an Original Cover Sheet4-10
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Adjusting Text Properties
You can change text properties whenever you want. When you change text 
properties, all text inside the selected text box is affected.

NOTE
 

Text properties for field settings inside a text box are also changed according to the text 
properties you specified. For details on field features, see "Specifying Fields," on p. 4-16.

Font

1 Click inside the text box.

The text box is now ready for editing.

2 Select the desired font from the [Font] drop-down menu on the 
toolbar.

Font Size

1 Click inside the text box.

The text box is now ready for editing.

2 Select the desired font size from the font [Size] drop-down 
menu on the toolbar.

You can also enter the desired font size directly into [Size].

Font Font Size Font Color Bold Underline

Formatting

Italic

Center
Left Right

Alignment
Creating an Original Cover Sheet 4-11
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Font Color

1 Click inside the text box.

The text box is now ready for editing.

2 Select the desired font color from the font [Color] drop-down 
menu on the toolbar.

Bold Formatting

1 Click inside the text box.

The text box is now ready for editing.

2 Click [ ] (Bold) on the toolbar.

To undo the bold formatting, click [ ] (Bold) once more.

Italic Formatting

1 Click inside the text box.

The text box is now ready for editing.

2 Click [ ] (Italic) on the toolbar.

To undo the italic formatting, click [ ] (Italic) once more.

Underlining

1 Click inside the text box.

The text box is now ready for editing.

2 Click [ ] (Underline) on the toolbar.

To undo the underlining, click [ ] (Underline) once more.
Creating an Original Cover Sheet4-12
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Aligning Text

1 Click inside the text box.

The text box is now ready for editing.

2 Click [ ] (Align Left), [ ] (Align Center), or [ ] (Align Right) 
on the toolbar.

Specifying Text Properties
You can specify all of the properties for text inside a text box simultaneously.

[Preview] inside the [Text Properties] dialog box displays a preview of how the text 
would appear with the currently selected settings. Use it as a guide if you are 
specifying settings.

1 Click inside the text box.

The text box is now ready for editing.

2 Click [ ] (Properties) on the toolbar.

You can also select [Properties] from the [Edit] menu.

You can also right-click inside the text box ➞ click [Properties].

The [Text Properties] dialog box opens.
Creating an Original Cover Sheet 4-13
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3 Select [Font], [Font Style], and [Size] from the respective list 
boxes.

You can also enter the desired font size directly into [Size].

4 Select [Strikethrough] or [Underline] to draw a line through or 
to underline text.

5 Select the desired text color from [Color].

6 Specify [Alignment] for the text.

7 Click [OK].
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Specifying Text Box Properties
Follow the procedure below to specify the type of border, border color, and 
background color of the selected text box.

1 Click anywhere on the border of the text box.

The border of the text box is selected.

2 Click [ ] (Properties) on the toolbar.

You can also select [Properties] from the [Edit] menu.

You can also display the [Text Box Properties] dialog box by double-clicking 
anywhere on the border of the text box.

The [Text Box Properties] dialog box opens.

3 Select the desired border type from [Line Style].

4 Specify the [Width] setting to set the thickness of the border.

NOTE
 

The [Width] setting is available only if [Line Style] is set to 'Solid'.

5 Select the desired color of the border from [Color].

6 Select the desired background color for the text box from [Fill 
in].

7 Click [OK].
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Specifying Fields
You can show sender or fax recipient information, such as the name, fax number, 
company name, and department/division name on the cover sheet using a feature 
called a "field."

Fields are objects in the cover sheet that you can replace with data when sending a 
fax. Actual sender and recipient information as specified in the fax driver is 
automatically inserted in the corresponding fields on the cover sheet during 
transmission.

Available fields:

• Sender information: Name, Fax Number, Company, Dept./Div.
• Recipient information: Name, Fax Number, Company, Dept./Div.
• Sheets to send
• Other information: Remark, Comment
A recipient information field that contains multiple values is called a "repeating 
field." This feature is convenient for using the same cover sheet to send faxes to 
multiple recipients.

The repeating field is used to insert data for every recipient specified in the fax 
driver.

FAX

From
[Sender Name]

To
[Recipient Name]

Substituted
when the fax
is sent.

[Remark]

FAX

From
George Smith

To
Mr. David Walters

[Confidential]

FAX FAX

[Recipient Company] XXX Company

Dept. A

Dr. Curtis

Dept. B

Mr. Alter

Dept. C

Mr. Green

Dept. D

Ms. Harrison

Substituted
for each
recipient when
the fax is sent.[Begin Repeat]

[Recipient Dept./Div.]

[Recipient Name]

[End Repeat]
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In addition to the [Sender Information] and [Recipient Information] fields, you can 
also insert [Sheets to Send], [Remark], and [Comment] fields on the cover sheet. 
When the fax is sent, the number of sheets to send as a fax specified in the fax 
driver is inserted in the [Sheets to Send] field, information specified in the fax driver, 
such as [Urgent] or [Confidential] is inserted in the [Remark] field, and comments 
specified in the fax driver are entered in the [Comment] field.

Inserting Sender and Recipient Information Fields When Editing Text

1 Inside the text box, place the cursor to where you want to 
insert the field.

2 Click the [Insert] menu ➞ point to [Sender Information] or 
[Recipient Information] ➞ select the field (such as [Name], 
[Fax Number], [Company], and [Dept./Div.]) to insert.

The selected field is inserted.

NOTE
 

If you select [Insert All], all of the available fields for sender or recipient information 
are inserted simultaneously. The fields are inserted in this order: [Name], [Fax 
Number], [Company], and [Dept./Div.]. You can change the position of the fields as 
needed.

Inserting Sender and Recipient Information Fields When Not Editing 
Text

1 Click the [Insert] menu ➞ point to [Sender Information] or 
[Recipient Information] ➞ select the field (such as [Name], 
[Fax Number], [Company], and [Dept./Div.]) to insert.

2 Drag the pointer on the area of the cover sheet to where you 
want to insert the field.

A square or rectangular text box containing the selected field appears.

NOTE
 

If you select [Insert All], all of the available fields for sender or recipient information 
are inserted simultaneously. The fields are inserted in this order: [Name], [Fax 
Number], [Company], and [Dept./Div.]. You can change the position of the fields as 
needed.
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Inserting Repeating Fields
Follow the procedure below to show information for multiple recipients on the cover 
sheet when sending a fax.

1 Insert the desired recipient information field, such as [Name], 
[Fax Number], [Company], and [Dept./Div.].

2 Inside the text box, place the cursor to the left of the field to 
repeat.

3 Click the [Insert] menu ➞ point to [Recipient Information] ➞ 
click [Begin Repeat].

The [Begin Repeat] field is inserted.

4 Inside the text box, place the cursor to the right of the field to 
repeat.

5 Click the [Insert] menu ➞ point to [Recipient Information] ➞ 
click [End Repeat].

The [End Repeat] field is inserted.

The field between the [Begin Repeat] and [End Repeat] fields is replaced with 
multiple recipients' information when sending a fax.

NOTE
 

The text box may not be able to accommodate all of the actual data for a repeating 
field if a large number of recipients are specified for sending a fax. In this case, a 
new page is automatically created and data that does not fit into the text box 
displays from the top of the new page.
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Inserting Borders Between Repeating Fields
When you specify a repeating field for recipient information, you can also select 
whether to insert borders between the values for easier reading.

1 Click the [Insert] menu ➞ point to [Recipient Information] ➞ 
click [Borders].

The [Border Settings] dialog box opens.

2 Select [Insert a Border Between Repeats] to insert borders 
between multiple values in a repeating recipient information 
field.

If you do not want to insert borders between the values, deselect this check box 
➞ click [OK]. 

3 Select the type of line to use as the border from [Line Style].

4 Specify the [Width] setting to set the thickness of the borders.

NOTE
 

The [Width] setting is available only if [Line Style] is set to 'Solid'.

5 Select the desired color of the borders from [Color].

6 Click [OK].
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Inserting Sheets to Send Field When Editing Text

1 Inside the text box, place the cursor where you want to insert 
the field.

2 From the [Insert] menu, select [Sheets to Send].

The [Sheets to Send] field is inserted.

Inserting Sheets to Send Field When Not Editing Text

1 From the [Insert] menu, select [Sheets to Send].

2 Drag the pointer on the area of the cover sheet to insert the 
field.

A square or rectangular text box containing the selected field appears.

Inserting Remark and Comment Fields When Editing Text

1 Inside the text box, place the cursor to where you want to 
insert the field.

2 From the [Insert] menu, select either [Remark] or [Comment].

The [Remark] field or the [Comment] field is inserted depending on your selection.

Inserting Remark and Comment Fields When Not Editing Text

1 From the [Insert] menu, select either [Remark] or [Comment].

2 Drag the pointer on the area of the cover sheet to insert the 
field.

A square or rectangular text box containing the selected field appears.
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Creating Objects
You can draw lines, rectangles, rounded rectangles, or ovals on the cover sheet. 
You can also change their properties once they are drawn.

Lines

1 Click [ ] (Line) on the toolbar.

You can also select [Line] from the [Drawing] menu.

2 Drag the pointer on the area of the cover sheet to draw the 
line.

Rectangles

1 Click [ ] (Rectangle) on the toolbar.

You can also select [Rectangle] from the [Drawing] menu.

2 Drag the pointer on the area of the cover sheet to draw the 
rectangle.

To draw a square, hold down [SHIFT] on the keyboard while dragging.

Rounded Rectangles

1 Click [ ] (Rounded Rectangle) on the toolbar.

You can also select [Rounded Rectangle] from the [Drawing] menu.

2 Drag the pointer on the area of the cover sheet to draw the 
rounded rectangle.

To draw a rounded square, hold down [SHIFT] on the keyboard while dragging.

You can adjust the degree of the curve or the roundness of the corners of the 
rounded rectangle. To do so, click anywhere outside the newly created rounded 
rectangle ➞ click the rounded rectangle again ➞ click and drag the inner handle 
in its upper right corner to change the degree of the curve.
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Ovals

1 Click [ ] (Oval) on the toolbar.

You can also select [Oval] from the [Drawing] menu.

2 Drag the pointer on the area of the cover sheet to draw the 
oval.

To draw a circle, hold down [SHIFT] on the keyboard while dragging.

Inserting Images

1 Click [ ] (Image) on the toolbar.

You can also select [Image] from the [Insert] menu.

The [Open] dialog box opens.

2 Specify the file name of the bitmap file that you want to insert.

NOTE
 

Clicking [Preview] opens the [Preview] dialog box, where an image of the 
highlighted bitmap file is displayed.

3 Click [Open].

 

Editing Objects
You can copy, move, and delete objects, such as lines, rectangles, rounded 
rectangles, ovals, images, and text boxes on the cover sheet.

Selecting an Object

1 Click the object to select.

You can also drag the pointer completely over the object.

The object is selected.
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NOTE
 

You can also select multiple objects by holding down [SHIFT] on the keyboard and 
clicking each object that you want to select, or by dragging the pointer completely 
over the objects. If you want to deselect any of the objects you selected, hold down 
[SHIFT] on the keyboard ➞ click the objects that you want to deselect.

Moving an Object within the Same Cover Sheet

1 Select the object to move.

NOTE
 

You can select multiple objects and move them at the same time.

2 Drag the selected object to the desired location.

You can also use any of the four arrow keys [ ], [ ], [ ], or [ ] to move the 
object in the desired direction in 0.1 mm increments.

NOTE
 

• Hold down [SHIFT] on the keyboard while dragging to move the object horizontally 
or vertically only.

• Hold down [CTRL] on the keyboard while dragging to copy the selected object and 
drag the copy to the desired location.

• If [Snap to Grid] is specified, holding down [SHIFT] on the keyboard while pressing 
an arrow key moves the object in the direction of the arrow in half-grid space 
increments. If [Snap to Grid] is not specified, holding down [SHIFT] on the 
keyboard while pressing an arrow key moves the object in the direction of the arrow 
in 2.0 mm increments.

Moving an Object to a Different Cover Sheet

1 Select the object to move.

NOTE
 

You can select multiple objects and move them at the same time.

2 Click [ ] (Cut) on the toolbar.

You can also select [Cut] from the [Edit] menu.
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3 Display the second cover sheet.

NOTE
 

If the second cover sheet is open, you can select it from the [Window] menu.

4 Click [ ] (Paste) on the toolbar.

You can also select [Paste] from the [Edit] menu.

The selected object is moved to the active cover sheet.

Resizing an Object

1 Select the object whose size you want to change.

NOTE
 

You can select multiple objects and change all of their sizes at the same time.

2 Drag any handle on the selected object to change its size.

NOTE
 

The shape of the pointer changes depending on which handle you place it over.
- Dragging the handles on the top and bottom sides of the object changes its 

height.
- Dragging the handles on the left and right sides of the object changes its width.

- Dragging the handles on the corners of the object changes both its height and 
width.

Copying an Object by Dragging

1 Select the object to copy.

NOTE
 

You can select multiple objects and copy them at the same time.

2 Hold down [CTRL] on the keyboard ➞ drag the selected 
(copied) object to the desired location.

NOTE
 

Dragging the selected object without holding down [CTRL] on the keyboard moves 
the object to the new location instead of copying it.
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Copying an Object by Using Button or Menu Commands
You can use button and menu commands to copy an object, such as a line, 
rectangle, rounded rectangle, oval, image, or text box on the same cover sheet or to 
another cover sheet.

Follow the procedure below.

1 Select the object to copy.

NOTE
 

You can select multiple objects and copy them at the same time.

2 Click [ ] (Copy) on the toolbar.

3 You can also select [Copy] from the [Edit] menu.

4 If you want to copy the object to a different cover sheet, 
display the second cover sheet.

NOTE
 

If the second cover sheet is open, you can select it from the [Window] menu.

5 Click [ ] (Paste) on the toolbar.

You can also select [Paste] from the [Edit] menu.

The selected object is copied.

NOTE
 

• You cannot copy an object to a different cover sheet by dragging.

• To copy text, drag the pointer over the text to select it ➞ click [ ] (Copy) or select 
the [Copy] command to copy it ➞ click [ ] (Paste) or select the [Paste] command. 
If you want to copy text within the same text box, hold down [CTRL] on the 
keyboard while dragging the selected text.
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Duplicating an Object
Duplicating enables you to copy and paste an object in one operation.

1 Select the object to duplicate.

NOTE
 

You can select multiple objects and duplicate them at the same time.

2 Click [ ] (Duplicate) on the toolbar.

You can also select [Duplicate] from the [Edit] menu.

The selected object is duplicated.

Deleting an Object

1 Select the object to delete.

NOTE
 

You can select multiple objects and delete them at the same time.

2 Click [ ] (Delete) on the toolbar.

You can also select [Delete] from the [Edit] menu, or press [DELETE] on the 
keyboard.

The selected object is deleted.

Grouping Objects
You can edit or handle multiple objects that are grouped together as a single object. 
You can move, copy, or change the size of grouped objects in a single operation. 
You can also simultaneously modify the properties of all objects in the group.

1 While holding down [SHIFT] on the keyboard, select all the 
objects to group.

2 Click [ ] (Group) on the toolbar.

You can also select [Group] from the [Layout] menu.
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You can ungroup objects by selecting the group of objects that you want to 
ungroup and clicking [ ] (Ungroup) on the toolbar or selecting [Ungroup] from 
the [Layout] menu.

 

Specifying Object Properties
Follow the procedure below to change the line style, line color, and background 
color of objects, such as lines, rectangles, rounded rectangles, ovals, and images.

1 Select the object whose properties you want to change.

NOTE
 

You can select multiple objects and change their properties at the same time.

2 Click [ ] (Properties) on the toolbar.

You can also select [Properties] from the [Edit] menu, or display the [Object 
Properties] dialog box by double-clicking the selected object.

The [Object Properties] dialog box opens.

3 Select the desired line type for the object from [Line Style].

4 Specify the [Width] setting to set the thickness of the line.

NOTE
 

The [Width] setting is available only if [Line Style] is set to 'Solid'.

5 Select the desired line color for the object from [Color].

6 Select the desired background color for the object from [Fill 
in].

NOTE
 

[Fill in] cannot be specified if the selected object is either a line or an image.

7 Click [OK].
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Arranging Objects
You can rearrange the order and appearance of objects, such as lines, rectangles, 
rounded rectangles, ovals, images, and text boxes on the cover sheet.

Changing the Order of Display
If multiple objects overlap, you can specify the order in which they overlap. Use the 
following four commands to change the order of display of overlapping objects:

• [Bring to Front]: Moves the selected object to the front.
• [Send to Back]: Moves the selected object to the back.
• [Bring Forward]: Moves the selected object one level higher.
• [Send Backward]: Moves the selected object one level lower.

1 Select the object whose display order you want to change.

NOTE
 

• You can select multiple objects and change the order of display for all of them at the 
same time.

• If the object you want to select lies behind other objects and thus is hidden from 
view, press [TAB] on the keyboard repeatedly until the object you want is selected. 
You can also select in reverse order by holding down [SHIFT] on the keyboard 
while pressing [TAB] on the keyboard.

2 Click [ ] (Bring to Front), [ ] (Send to Back), [ ] (Bring 
Forward), or [ ] (Send Backward) on the toolbar.

NOTE
 

You can also select [Bring to Front], [Send to Back], [Bring Forward], or [Send 
Backward] from the [Layout] menu.
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Aligning Multiple Objects
You can align multiple selected objects according to their left edge, right edge, top 
edge, bottom edge, or center in one operation. The position of the last selected 
object becomes the point of reference of alignment.

Use the following commands to change the alignment of the selected objects:

• [Align Left]: Aligns the left edge of all objects along the left edge of the last 
selected object.

• [Align Center]: Aligns the left-right center axis of all objects along the left-right 
center axis of the last selected object.

• [Align Right]: Aligns the right edge of all objects along the right edge of the last 
selected object.

• [Align Top]: Aligns the top edge of all objects along the top edge of the last 
selected object.

• [Align Middle]: Aligns the top-bottom center axis of all objects along the 
top-bottom center axis of the last selected object.

• [Align Bottom]: Aligns the bottom edge of all objects along the bottom edge of the 
last selected object.

1 While holding down [SHIFT] on the keyboard, select the 
objects to align.

Select the object to be used as the point of reference last.

NOTE
 

If you drag the pointer to select multiple objects, the object positioned in the front is 
used as the point of reference.

2 Click [ ] (Align Left), [ ] (Align Center), [ ] (Align Right), 
[ ] (Align Top), [ ] (Align Middle), or [ ] (Align Bottom) 
on the toolbar.

You can also click the [Layout] menu ➞ point to [Distribute Horizontally] or 
[Distribute Vertically] ➞ select the type of alignment you want.
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Specifying Grid Options
The grid function is useful for arranging created objects.

Showing Grids
You can display the grid on the cover sheet to help you create and arrange objects.

1 On the toolbar, click [ ] (Show Grids) to activate the grid.

You can also activate the command by clicking [Show Grids] from the [View] 
menu.

Hide the grid by clicking the activated [ ] (Show Grids) to deactivate it or by 
clicking [Show Grids] from the [View] menu.

Snapping Objects to Grid
If you activate the [Snap to Grid] setting for the cover sheet, objects are aligned 
along the grid when they are moved or resized on the cover sheet.

1 On the toolbar, click [ ] (Snap to Grid) to activate the grid.

You can also activate the command by clicking [Snap to Grid] from the [View] 
menu.

Deactivate the [Snap to Grid] setting by clicking the activated [ ] (Snap to Grid) 
or by clicking [Snap to Grid] from the [View] menu.

NOTE
 

[Snap to Grid] is available only after this setting is specified. It does not affect 
objects that are modified before this setting is specified.

Specifying Grid Properties
Follow the procedure below to specify the properties for the grid on the cover sheet, 
such as type, color, and spacing. You can also specify whether to display the grid 
and whether to snap objects to the grid.

1 Select [Grid Properties] from the [View] menu.

The [Grid Properties] dialog box opens.
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2 Select [Show Grids].

Deselect the check box if you do not want to display the grid.

NOTE
 

Deselecting this check box disables the [Type], [Color], and [Spacing] settings.

3 Select [Dotted] or [Dashed].

4 Click the button to the right of [Color].

The [Color Setting] dialog box opens.

5 Select a color to use as the grid's basic color in the [Color 
Setting] dialog box.

● To select basic color:

❑ Select the color you want from [Basic colors].
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● To create your own color:

❑ Click on a color that is the closest to the color you want.

❑ Click [Define Custom Colors].

The color matrix appears on the left of the [Color Setting] dialog box.

❑ Adjust the luminosity of the color ➞ click [Add to Custom Colors].

6 Click [OK] in the [Color Setting] dialog box.

7 Specify the [Horizontal] and [Vertical] spacing for the grid.

NOTE
 

You can change the unit of measurement for the spacing in the [Unit Setting] dialog 
box displayed by selecting [Unit] from the [View] menu.

8 To align objects along the grid, select [Snap to Grid].

To deactivate [Snap to Grid], deselect the check box.

9 Click [OK].

NOTE
 

Clicking [Restore Defaults] in the [Grid Properties] dialog box restores all [Grid 
Properties] settings for the cover sheet to their default values.
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Follow the procedure below to print the cover sheet.

1 Click [ ] (Print) on the toolbar.

You can also select [Print] from the [File] menu.

The [Print] dialog box opens.

2 Select the printer ➞ click [OK].

As necessary, click [Properties] to specify detailed print settings.

3 Specify the number of copies to print.

NOTE
 

[All] is the only active selection for the [Print range] setting because the cover sheet 
consists of only one page.

4 Click [OK].
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Registering an Original Cover Sheet as a Template
You can register the cover sheet created with the Canon Cover Sheet Editor with 
the fax driver for use as a template.

1 On the [Start] menu, point to [Settings] ➞ click [Printers].

NOTE
 

• If you are using Windows XP Professional/Server 2003, on the [Start] menu, click 
[Printers and Faxes].

• If you are using Windows XP Home Edition, on the [Start] menu, click [Control 
Panel] ➞ [Printers and Other Hardware] ➞ [Printers and Faxes].

2 In the [Printers] folder, right-click the printer icon for your fax 
➞ click [Properties] (Windows 98/Me), [Document Default] 
(Windows NT 4.0), or [Printing Preferences] (Windows 2000/
XP/Server 2003).
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3 Click the [Register Cover Sheet] tab.

4 Click [Register].

The [Register Cover Sheet] dialog box opens.

5 Select the cover sheet template file ➞ click [Open].

The selected template is added to [Style] in the [Register Cover Sheet] sheet.

NOTE
 

In addition to the default templates, you can add up to 30 templates to the fax 
driver.
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CHAPTER

5
Special Fax Driver Options

This chapter describes instructions for using the Job Accounting features, and for setting the 
time to send a fax.
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Job Accounting Features
This section describes Job Accounting, how to specify the ID and password for Job 
Accounting, and how to fax with Job Accounting.

 

Job Accounting Overview
Job Accounting enables you to sum fax totals for each department or user for 
management purposes, under an ID and a password assigned to each department 
or user.

A document will be faxed only if the specified ID and password are verified as valid. 

IMPORTANT
 

• If you are using a shared fax in the Print Server (Point and Print) environment, it is 
necessary to install the Canon Driver Information Assist Service in the server PC in order 
to use the Job Accounting feature. (See "Installing the Canon Driver Information Assist 
Service," on p. 2-36.)

• If you are using a local fax (connected to an LPT port, USB port, etc.), you cannot use 
the Job Accounting feature.

NOTE
 

Job Accounting is not available for the imageRUNNER 400/330, imageRUNNER 400/
330-P1/R1, and LASER CLASS 510.

 

Specifying the ID and Password
In order to fax documents using the Job Accounting feature, follow the procedure 
below to specify the ID and password.

1 On the [Start] menu, point to [Settings] ➞ click [Printers].

NOTE
 

• If you are using Windows XP Professional/Server 2003, on the [Start] menu, click 
[Printers and Faxes].

• If you are using Windows XP Home Edition, on the [Start] menu, click [Control 
Panel] ➞ [Printers and Other Hardware] ➞ [Printers and Faxes].
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2 In the [Printers] folder, right-click the printer icon for your fax 
➞ click [Properties].

3 From the fax properties dialog box, click the [Configuration] 
sheet (for Windows 98/Me) or [Device Settings] sheet (for 
Windows NT 4.0/2000/XP/Server 2003).

For details on how to access the fax properties dialog box, see "Sending a 
Document," on p. 3-2.

NOTE
 

For the imageRUNNER 400/330 and imageRUNNER 400/330-P1/R1, 
[Configuration] sheet is displayed no matter what you are using which operating 
system.

4 Click [Get Device Status] to confirm that [Job Accounting] is 
selected, or manually select [Job Accounting] and [Allow 
Password Setting] if necessary.
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5 Click [Settings] to open the [ID/Password Settings] dialog box 
➞ enter the ID and password.

NOTE
 

• The ID and password can be changed when faxing a document only if [Confirm ID/
Password when Sending Fax] is selected in the [ID/Password Settings] dialog box.

• For Windows NT 4.0/2000/XP/Server 2003, you can specify the password in the 
[ID/Password Settings] dialog box only if [Allow Password Setting] is selected in the 
[Device Settings] sheet.

• You can leave the password blank.

6 Click [Verify] to confirm that the specified ID and password are 
valid.

7 Click [OK].

 

Faxing with Job Accounting (Windows 98/Me)
To fax with Job Accounting, follow the procedure below.

1 In application software, with the document open, select 
[Print].

2 Click [Properties] in the [Print] dialog box.

3 Specify the various settings in the fax properties dialog box.
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4 Click [OK] to close the fax properties dialog box ➞ click [OK] 
in the [Print] dialog box.

5 If the [Confirm ID/Password] dialog box opens, enter the ID 
and the password ➞ click [OK].

The document is faxed with the specified ID and password.

NOTE
 

• The [Confirm ID/Password] dialog box opens only if [Confirm ID/Password when 
Sending Fax] is selected in the [ID/Password Settings] dialog box. Otherwise, the 
document is faxed under the previously specified ID and password.

• You can leave the password blank.

 

Faxing with Job Accounting (Windows NT 4.0/2000/XP/
Server 2003)

The procedure for faxing with Job Accounting differs depending on whether [Allow 
Password Setting] is selected in the [Device Settings] sheet.

With Allow Password Setting Selected
The password for Job Accounting can be specified in advance in the [ID/Password 
Settings] dialog box.

1 In application software, with the document open, select 
[Print].

2 Click [Properties] in the [Print] dialog box.
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3 Specify the various settings in the fax properties dialog box.

4 Click [OK] to close the fax properties dialog box ➞ click [OK] 
in the [Print] dialog box.

The document is faxed with the specified ID and password.

With Allow Password Setting Not Selected
The password for Job Accounting cannot be specified in the [ID/Password Settings] 
dialog box.

1 In application software, with the document open, select 
[Print].

2 Click [Properties] in the [Print] dialog box.

3 Specify the various settings in the fax properties dialog box.

4 Click [OK] to close the fax properties dialog box ➞ click [OK] 
in the [Print] dialog box.

5 In the [Confirm ID/Password] dialog box, enter the password ➞ 
change the ID, if necessary.

NOTE
 

You can leave the password blank.

6 Click [OK].

The document is faxed with the specified ID and password.
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By temporarily storing data in the printer, you can set the time at which a fax will be 
sent.

1 In application software, with the document open, select 
[Print].

The [Print] dialog box opens.

2 In the [Print] dialog box, select your fax driver name from 
[Name] ➞ click [OK].

3 In the [Sending Settings] sheet, specify the name and fax 
number of the fax recipient ➞ click [Add to Recipient List].

4 Select [Set the Time to Send] ➞ specify the time to send a fax.
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5 Click [OK] in the fax properties dialog box.

The data is stored temporarily in the printer, and the fax is sent at the specified 
time.
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Appendix

This chapter provides information about additional software used with the fax drivers.
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Additional Software
This section describes additional software used with the fax driver.

 

Canon Port Setting Tool
The Canon Port Setting Tool enables you to correspond the device driver installed 
in your computer with the network address for the device. If you cannot set up the 
fax configuration automatically or use the Job Accounting feature properly when 
you are using SMB (Server Message Block) or NDPS (Novell Distributed Print 
Services), you need to specify the port using the Canon Port Setting Tool.

1 In Windows Explorer, double-click the following folders: 
[Program Files] ➞ [Canon] ➞ [Portset].

2 In the [Portset] folder, double-click the [Portset.exe] icon to 
start the Canon Port Setting Tool.

NOTE
 

• The Canon Port Setting Tool is installed with the fax driver.

• For more information about using the Canon Port Setting Tool, see the Online Help. 
To display the Online Help, start the Canon Port Setting Tool ➞ click [Help].
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Device Status Extension (Windows 2000/XP/Server 2003)
If you use a shared fax in Windows 2000/XP/Server 2003, you can browse 
information on the shared fax and manage fax jobs through a web browser.

Installing Device Status Extension in Windows 2000/XP/Server 2003 enables you 
to browse detailed information on faxes supporting Device Status Extension. 
Device Status Extension also enables you to start the NetSpot Console from the 
[Device Status Extension] window to set up faxes. NetSpot Console is software 
which monitors job status and devices connected to the network.

NOTE
 

• For instructions on how to install and use the Device Status Extension, see the 
README.TXT file located in the following folders on the Printer Driver Software 
CD-ROM:

- \DSE\english\win2000
- \DSE\english\winxp

- \DSE\english\winServer2003

• Some products do not come with the Device Status Extension.
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Glossary
C
Canon Driver Information Assist Service

A software module that is specialized in retrieval of information from devices. When 
you are using a shared printer in the Print Server (Point and Print) environment, it is 
necessary to install the Canon Driver Information Assist Service in the server PC in 
order to set up the printer configuration automatically or to use the Job Accounting 
feature.

D
Device Status Extension

An extension for Windows 2000/XP/Server 2003 that enables you to view information 
about shared printers, and to manage print jobs using your Web browser. If you are 
using NetSpot Console, Device Status Extension also enables you to start NetSpot 
Console from the Device Status Extension screen to set up printers.

L
Log on

Entering a user name and password as a means of user authentication to start a 
computer session or access to a service.

N
NDPS

Novell Distributed Print Services. A printing system developed by Novell, for 
managing printers in a network environment.

NetSpot Console
A web-based version of NetSpot. Being browser enabled, it can be used to browse 
and manage network devices.
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P
Port Setting Tool

A software utility that enables you to confirm and reset the correspondence between 
the port of the device driver installed in Windows and its network address. The Port 
Setting Tool is useful when the printer driver is unable to acquire the device status 
information properly. If NetSpot Job Monitor is installed in your computer, you can 
also use this utility to set the update interval for acquiring information and for checking 
device types.

Protocol
A set of rules that govern the transmission of data across a network.

S
Sender's Name

Your personal or organization name. The sender's name, fax number, date, and time 
sent are printed on each page that you send. You can register up to 99 sender 
names, that are selected using the TTI selector, before sending.

SMB
Server Message Block. A protocol that provides file and printer sharing over a 
network for Windows computers.

Subaddress
Subaddress is the Global telecommunications standard provided by ITU-T 
(International Telecommunication Union - Telecommunication Standardization 
Sector). As long as the remote party's machine supports the same standards, 
confidential or relayed communications are possible by attaching a subaddress and a 
password in advance.

T
TCP/IP

Transmission Control Protocol/Internet Protocol. The protocol used to connect to the 
Internet and to wide area networks.

Transmission Time
A fax transmission consists of three stages: the machine sending the fax connects 
with the machine receiving it, the message is then transmitted, after which the sender 
and the receiver exchange signals to confirm the end of transmission. The 
transmission time described in this guide is not the total time required for the entire 
transmission, but only the time taken for the message transmission. 
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Index
A
Add Port, 2-10

Add Printer Wizard, 2-20

Additional software, 6-2

Canon Port Setting Tool, 6-2

Device Status Extension (Windows 2000/XP/

Server 2003), 6-3

Address book, 3-11, 3-12, 3-13, 3-24

Address book entries, 3-13

Group entry, 3-19

Person (single) entry, 3-13

Alternate fax driver, 2-43

Attaching cover sheet, 3-27

C
Canon Driver Information Assist Service, 2-6, 

2-14, 2-36, 2-43, 2-50, 5-2, 6-4

Canon Port Setting Tool, 6-2, 6-5

Client PC, 2-18

Confidential document by fax, 3-5

Cover Sheet, 3-4, 3-8, 3-27

Cover sheet template, 3-27, 4-2

Creating original cover sheet, 4-10

Adjusting text properties, 4-11

Arranging objects, 4-28

Creating objects, 4-21

Editing objects, 4-22

Inserting text, 4-10

Specifying field, 4-16

Specifying grid options, 4-30

Specifying object properties, 4-27

D
Device status extension (Windows 2000/XP/

Server 2003), 6-3, 6-4

Driver Information Assist Service, 2-6, 2-14, 

2-36, 2-43, 2-50, 5-2, 6-4

Dynamic installation, 2-11

F
Fax board, 2-48

Fax memory, 2-51

Fax send time, setting, 5-7

Faxing document, 3-2

Sending document, 3-2

Sending to Remote Memory Box, 3-5

Faxing with Job Accounting, 5-5

With allow password, 5-5

Without allow password, 5-6

Field, 4-16

Border between repeating fields, 4-19

Remark and comment, 4-20

Repeating fields, 4-18

Sender and recipient information, 4-17

Sheets to send, 4-20

Field feature, 4-2

G
Grid options, specifying, 4-30

Showing grids, 4-30

Snapping objects to grid, 4-30

Specifying grid properties, 4-30
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Group entry, 3-19

Delete group, 3-23

Edit group, 3-21

New group, 3-19

H
Help, 1-7

I
Installing Cover Sheet Editor, 4-3

Installation, 4-3

Launching, 4-5

Uninstalling, 4-6

Installing fax driver, 2-2

Alternate fax driver (Windows NT 4.0/2000/XP/

Server 2003), 2-18

Dynamic installation, 2-11

Standard installation, 2-3

Using Add Printer Wizard, 2-20

Installing software, 2-2

Canon Driver Information Assist Service, 2-6, 

2-14, 2-36, 2-43, 2-50, 5-2, 6-4

Fax driver, 2-2

Fax driver through USB connection, 2-22

Uninstalling fax driver, 2-46

Updating alternate fax driver (Windows NT 4.0/

2000/XP/Server 2003), 2-43

Updating existing fax driver, 2-39

Introduction, 1-2

Supported Canon products, 1-2

J
Job Accounting features, 5-2

Faxing with job accounting, 5-4, 5-5

Overview, 5-2

Specifying ID and password, 5-2

L
License agreement, 2-4, 2-12, 2-37

Log on, 2-3, 6-4

Logo sheet, 3-30

M
Memory box, 3-2, 3-5, 3-7, 3-15

Messaging API Address Book, 3-24

Microsoft Windows 2000, 1-2, 1-5

Microsoft Windows 98, 1-2, 1-5

Microsoft Windows Me (Millennium Edition), 1-2, 

1-5

Microsoft Windows NT 4.0, 1-2, 1-5

Microsoft Windows Server 2003, 1-2, 1-5

Microsoft Windows XP, 1-2, 1-5

N
NDPS (Novell Distributed Print Services), 6-2, 

6-4

NetSpot Console, 6-3, 6-4

Network printer, 2-3, 2-9

O
Objects, arranging, 4-28

Aligning multiple objects, 4-29

Changing order of display, 4-28

Objects, creating, 4-21

Inserting images, 4-22

Lines, 4-21

Ovals, 4-22

Rectangles, 4-21
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Rounded rectangles, 4-21

Objects, editing, 4-22

Copying by dragging, 4-24

Copying by using button or menu commands, 

4-25

Deleting, 4-26

Duplicating, 4-26

Grouping, 4-26

Moving to different cover sheet, 4-23

Moving within same cover sheet, 4-23

Resizing, 4-24

Selecting, 4-22

Online Help, 1-7

Opening, saving, and closing file, 4-7

Closing file, 4-9

Creating new file, 4-7

Opening file, 4-7

Opening saved cover sheet, 4-8

Saving and closing file, 4-8

Operating system software, 2-21

P
Password, 3-5, 3-7, 3-16

Person (single) entry, 3-13

Delete entry, 3-18

Edit entry, 3-17

New entry, 3-14

Port selection, 2-8

Preview, 4-8

Primary number, 3-15

Printing cover sheet, 4-33

Process to install Fax Driver, 2-6, 2-14

Protocols, 1-2, 6-5

R
README. TXT file, 1-7

Recipient sheet, 3-29

Recipients, specifying, 3-9

Adding new name and fax number, 3-10

Adding recipient from address book, 3-11

Registering additional address book, 3-24

Registering original cover sheet as template, 

4-34

Remote Memory Box, 3-5

Repeating field, 4-16, 4-18

S
Secondary number, 3-15

Sender sheet, 3-28

Shared fax, 2-43

Shared printer, 2-18

Signature sheet, 3-30

SMB (Server Message Block), 6-2, 6-5

Specifying installed fax memory, 2-51

Specifying installed optional fax board, 2-48

Standard installation, 2-3

Standard port, 2-9

Subaddress, 3-5, 3-7, 3-16, 6-5

Subnet, 2-11

Supported Canon products, 1-2

System requirements, 1-5

Computer, 1-6

Operating system software, 1-5, 2-21

With server-based Computing Environment, 

1-5

T
TCP/IP protocol, 2-11

Text properties, 4-11

Aligning text, 4-13

Bold formatting, 4-12

Font, 4-11
Index6-8
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Font color, 4-12

Font size, 4-11

Italic formatting, 4-12

Specifying text properties, 4-13

Text box properties, 4-15

Underlining, 4-12

U
Updating existing fax drivers, 2-39

Using Add Printer Wizard, 2-40

Using Installer, 2-39

USB connection installation, 2-22

Plug and Play installation, 2-24, 2-27, 2-30, 

2-33

USB installation using Add Printer Wizard, 

2-23

USB standard installation, 2-22

USB port, 2-22

W
What is Cover Sheet Editor?, 4-2

Where to find Help, 1-7

Canon authorized dealers, 1-7

Online Help, 1-7

README. TXT file, 1-7

Windows Address Book, 3-24
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